Configuration Module
Introduction
The Configuration Module contains all the System setup information. Correctly setting up the CS Time
system is crucial as this will avoid many problems that could occur later. If it is your job to set up the
system to meet the needs of this installation then this section will assist you.
Generally, once the system is up and running, you will not need to reference this guide very often. If you
are going to be installing the system then this guide contains a mine of information on different setup
options, including the sometimes difficult task of describing your shift patterns to the computer.
For advanced users this manual also explains the use of the internal Macro Script language used by the
Processor. By understanding this language you are able to extend the processing rules by writing your
own.
There are a number of areas that need configuring, including employee groups, employee cards, public
holidays, processing options, variable employee field names and of course shift pattern setups. In addition
a “Configuration Check List” is provided below so that you can be sure the whole system is configured
correctly.
This is the basic Configuration check list that is to be used when setting up CS Time.
1. Activate the CS Time license using the supplied Activation Code. (Tools menu, Product
Registration).
2. Set the system Features as required (Setup menu, Features).
3. Set the system Options that are required (Setup menu, Server Options).
4. Edit the supplied Shift Time Rates if necessary (Setup menu, Shifts, Shift Time Rates).
5. Edit the supplied Shift Categories if necessary (Setup menu, Shifts, Shift Time Categories).
6. Edit the Daily shift patterns to suit your business (Setup menu, shifts, Daily Shifts).
7. Edit the Payroll Shift patterns to suit your business (Setup menu, shifts, Payroll Shifts).
8. Enable the Clocking Cards that are going to be used (Setup menu, Clocking Cards).
9. Create any employee classifications that you want (Employee menu, Classifications, Company
through to Workgroup).
10. Create any employee groups you want, including Quick Groups - so make sure you do the previous
step first (Employee menu, Group Selections).
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Main Window Background
On the main screen background the following information is displayed:
1. Supplier and Service Details. This is the contact information when you need support from your
supplier.
2. The Name of the Module and version number – Configuration Module.
3. The current date and time.
4. Number of items to be processed.
5. Server running indicator. If the Server Module is not running, a message will be displayed. (Server
not running)
6. The current level of the program.
7. The site for which the data is being viewed (Enterprise only).
8. The date and time when the last backup was made.
Toolbar Buttons
The following toolbar buttons are available:

Jump Start – will open the Jump Start option (Jump Start).

Edit Clocks – used to manage the TNA hardware (Setup/Clocks).

Edit Daily Shift Setup – used to view and edit the employees daily shift (Setup/Daily Shifts)
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Edit Payroll Shift Setup – used to view and edit employee payroll shifts (Setup/Payroll Shifts)

Edit Reports – used to edit reports or to add or remove their availability (Reports/Edit Reports)

Edit the Features required – used to select the system features that are to be used (Setup/
Features).
Edit the Server Options - used to select the system options that are to be used (Setup/Server
Options).

Toolbar Module Buttons
The following buttons can be found on the right hand side of the toolbar:

When selected will open the User Module.

When selected will close all the TNA Modules.

Toolbar Menu Options
File

From the File menu, the following options are available:
1. Print Setup. This option is used to set up the connection to the printer that will be used for the
printing of reports.
2. Import Reports. This option is used to import existing CS Time reports.
3. File Manager. Used to add, fix or rebuild index files that have been corrupted due to possible
power problems.
4. Verify Data. Assigns system default colors to everything.
5. Exit. Closes the module.
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Jump Start

The options available from the Jump-Start menu are used to quickly setup the CS Time system with the
minimum requirements needed for the system to operate and include:
1. Employees. This wizard is used to quickly setup the CS Time system with the minimum
requirements needed for the system to operate.
2. Classifications. This wizard is used to guide you through the steps required to set up the employee
classifications.
3. Leave. This wizard is used to set up all leave related information.
4. Reports. This wizard is used to select and setup the required reports.
5. Job Costing. This wizard is used when setting up the Job Costing Module.
6. Access Control. This wizard will assist you in setting up the Access control module.
7. Human Resources. This wizard will assist in setting up the Human Resources module.
8. Shifts. This wizard will assist you in defining employee shifts that are to be used.
Tasks

The option from the Tasks drop down menu is a wizard that guides you through each step of the selected
task. The tasks that can be performed are:
1. Add Shift. This wizard will assist you in creating an employee shift.
2. Edit Shift. This wizard is used to guide you through the steps required when changing an already
defined shift.
3. Configure Send-Email settings. This wizard is used to guide you through the steps required to set
up the send e-mail option.
4. Configure FTP Settings. This wizard is used to set up the FTP settings used in the Send To option.
Note: Each task guides you through doing something, one step at a time. Each step must be completed
before the next can be started, and each step is thoroughly explained on the screen. These tasks are ideal
for new users of CS Time, or if you are doing something you don't often do.

Setup

The options that are available from the Setup dropdown menu are used to manage the system and include:
1.
2.
3.
4.
5.

Features. This option enables system features to be activated so that they can be used.
Server Options. This option allows you to select options that affect how the system behaves.
Clocking Cards. This option is used to view and manage all the clocking cards.
Reasons. This option is used to view and manage the Reasons records.
Shifts. The options available for setting up shifts include:
a. Daily Shifts. This option is used to define a day shift for each different day type that
employees in the company can work.
b. Payroll Shifts. This option is used to build up a complete payroll shifts that can be worked
by the employees.
c. Shift Time Categories. This option is used to define the time categories (normal time,
overtime, etc) that the employees can work.
d. Shift Time Rates. This option is used to define the Shift Time Rates.
e. Macro Scripts. This option is used to manage macro’s for the system.
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6.
7.
8.

9.

10.

11.

f. Bulk Shift Changes. The only bulk shift change that can be performed is a Payroll Shift
Start Day which is used to change the payroll starting date for one or more shifts
simultaneously.
i. Payroll Shift Start Day. This is used to select the day of the week the payroll shift
must start on
Warnings. This option allows you to select which system Warnings are to be used.
Charge Rates. This option is used to define the different employee Charge Rates.
Leave. The options are used to setup all leave related information and includes:
a. Public Holidays. This option is used to view and manage the public holidays.
b. Leave Types. This option is used to set up the different leave types that are going to be
used.
c. Leave Scales. This is used to set up the rules that will be used to define and earn leave.
Job Costing. The options available from Job Costing include:
a. Jobs. This option is used to define the different jobs that are to be used.
b. Charge Rates. These are the different charge rates that are to be used.
c. Customers. Allows you create a list of customer contact details which can be linked to jobs.
Access Control. The options available for access control are:
a. Access Rights. This option is used to define the access rights that are to apply to
particular clocks and employees.
b. Areas. This option is used to define the different areas that are to be used.
c. Time Zones. This option is used to define the particular time zones that will be applied to
clocks and employees.
Clocks. The options available for the setting up of the clocking hardware include:
a. Clocks. This option is used to manage clocks associated with the system and also to add
new clocks.
b. Sirens. This option is used to manage any sirens that are connected to the system.
c. Function Keys. This option is used to set up how the clock’s function keys are to be used.
d. Clock Messages. This option is used to manage the messages that will be displayed on the
clocks.
e. Modems. If modems are used, this option will enable you to manage the modems.

Employee

The Employee Setup options are used to make changes to a group of employees and include:
1. Group Selections. This option is used to define different employee groups and which employees
belong to each.
2. Classifications. This option is used to define all classification types and include:
a. Company.
b. Branch.
c. Department.
d. Cost Centre.
e. Category.
f. Payscale.
g. Type.
h. Workgroup.
3. Human Resources. This option is used to define the human resources options that are to be used.
a. Courses.
b. Offenses.
c. Positions.
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d. Actions.
e. Medical Fitness.
f. Equipment.
g. Equipment Condition.
h. Language.
i. Class.
j. Bank Codes.
k. Branch Codes.
l. Payment Methods.
m. Account Types.
4. Custom Fields. If any custom filed have been defined, this menu item allows you to edit the
available selections for each field.
5. Lookup Filters. This is used to define certain lookup filters that would apply to a operator.
Reports

From the Reports menu, the following options are available:
1.
2.
3.
4.

Schedule Reports. This option is used to set up reports that are to be printed at particular times.
Choose Reports. Use to define which reports are to be used.
Choose Payroll Extracts. Used to define the payroll extracts that are to be used.
Assign Reports to Users (User Module). Used to define which reports are to be assigned to which
users in the User module.
5. Assign Reports to Users (Web). Used to assign particular reports to different Web users.
6. Edit Reports. Used to change existing reports to suit your requirements.
7. Edit Payroll Extracts. Used to change existing payroll extracts to suit your requirements.
Tools

From the Tools menu, the following options are available:
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Restore Default Windows Position. Used to restore all windows to their default size and position.
Clear Saved Login Details. Used to clear the default login details.
Browse Users. Used to configure the opertaor login details.
Set User Access. Used to set the security access to certain windows for each operator / group.
Change Password. Used to change the password of the operator currently logged in.
Product Registration. Used to register CS Time.
Remote Shutdown. Used to either warn or shut down all operators currently logged into CS Time.
Optimise for Remote Access. Used to optimise CS Time for Remote Access.
Enable Cue Cards. Used to enable / disable information cue cards in all windows of CS Time.
Monitor Server. Used to monitor the Server Module when running as a Service.

Help

From the Help menu, the following options are available:
1. CS Time Configuration Help. This option is used to open the windows help file.
2. CS Time Online Documentation. This will take you to the CS Time documentation website.
3. Email Support. This option will open a blank email that will be sent off to your support person’s
email address.
4. www.cstime.com. Connects to the CS Time Home Page.
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5. About: Displays the current version information.
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